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What is IGV

™| Integrative
Genomics
Viewer

A desktop application for integrated visualization of multiple data

types and annotations in the context of the genome.
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Installing IG

http://www.broadinstitute.org/igv

800

Home | Integrative Genomics Viewer

| » https://www.broadins(itute.org/igv/

[T Integrative
g’\/ Genomics

Viewer

» Hosted Genomes

» FAQ
IGV User Guide
File Formats
Release Notes

» Credits

Search website

Broad Home
Cancer Program
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What's New

NEWS  July 3, 2012. Soybean (Glycine max) and Rat

»temmin  (m5) genomes have been updated
5 April 20, 2012. IGV 2.1 has been released.

See the release notes for more details.

April 19, 2012. See our new |GV paper in Briefings in
Bioinformatics.

Overview

The Integrative Genomics Viewer (IGV) is a
hlgh—perfonnance visualization tool for

pl ion of large, ir
= genomlc datasets It supports a wide variety of

q

data types, including array-based and next-generation
sequence data, and genomic annotations.

Downloads

Please register to download IGV. After registering,
g you can log in at any time using your email
» a address. Permission to use IGV is granted under
the GNU LGPL license.

¢ | (Q Google

Citing IGV
To cite your use of IGV in your publication:

James T. Robinson, Helga Thorvaldsdéttir, Wendy Winckler,
Mitchell Guttman, Eric S. Lander, Gad Getz, Jill P. Mesirov.

Integrative Genomics Viewer. Nature Biotechnology 29
24-26 (2011), or

Helga Thorvaldsdottir, James T. Robinson, Jill P. Mesirov.
Integrative Genomics Viewer (IGV): high-performance
genomics data visualization and exploration.

Briefings in Bioinformatics 2012.

Funding

Development of IGV is made possible by funding from the
National Cancer Institute, the National Institute of General
Medical Sciences of the National Institutes of Health, and
the Starr Cancer Consortium.

%

IGV is participating in the GenomeSpace initiative.

GENOMESPACE
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Installing IGV

For email use

/ igv-team@broadinstitue.org

p I T Integrative
]g'v Genomics
Viewer

To use IGV, registration is
Click here to register.

If you have already registe please enter your registration email address below.

email addrigg. liav-team@hb

»Hosted Genomes
»FAQ
@IGV User Guide
@ File Formats
#Release Notes
=IGV for iPad
» Credits

Search website

| search

Broad Home

Cancer Program
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Launch IGV

e 00 / [ Downloads | Integrative € x \\_J 0y L
€& - C [ www.broadinstitute.org/igv/download bk .,‘,’, V4 -3 é - -
Download the Mac

Integrative
Genomics Downloads

Newer Integrative Genomics Viewer (IGV) (Version 2.3) Ap p b u n d I e a n d
Install IGV dOUbIe—C“Ck tO unZ|p |t.

Options for installing and running IGV:

» Hosted Genomes 1. (Mac only) Download and run the Mac applcation; or
»FAQ 2. (All systems) Use the Java Web Start buttons (Mac users: see below for limitations); or
=IGV User Guide 3. (All systems) Download the binary distribution and run IGV from the command line.

#File Formats

ELECIOLEED 1. Mac Application
®IGV for iPad
» Credits
Download and unzip the Mac App archive, then double-click the IGV application to run it. The Download
application can be moved to the "Applications" folder, or anywhere else. Note: This requires Java Mac App
Search website 7. Mac users with Java 6 (JRE 1.6) should use the binary distribution archive or the Java
— Web Start buttons below.
| search |

Broad Home
e s 2. Java Web Start

E E&q & 2 The buttons below use Java Web Start (JWS) to install and launch IGV directly from our web site.

©2013 Broad Institute *Mac Users: The Java Web Start option is not recommended for Mac OSX Mountain Lion or higher. Using it requires that you
set Gatekeeper security to its lowest level, and it is possible that even this will not be enough.

Chrome: Chrome does not automatically launch the Java Webstart files by default. Instead, the launch buttons below will
download a "jnlp" file. This should appear in the lower left corner of the browser. Double-click the downloaded file to run.

Windows users: To run with more than 1.2 GB of memory you must install 64-bit Java. Most Windows installs do not

include 64-bit Java by default, even if the op: g Sy is 64-bit. pting to use the 2GB or greater launch options
with 32-bit Java will result in the error “could not create virtual machine”.

Launch with 750 MB Launch with 1.2 GB Launch with 2 GB Launch with 10 GB

Maximum usable memory Maximum usable memory For large memory
for Windows OS with 32-bit | for 32-bit MacOS. machines with 64-bit Java.
Java.

3. Binary Distribution
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Using IGV: the basics

Hands-on exercise

Launch IGV

Select a reference genome
Load data

Navigate through the data
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Select the reference genome

e OO =

- Human hg18 s Al

Select genome from
the drop-down menu

—— }___h DT UPRP U 1 WA WVUT S0P BAVTW DRY DPIRR I I JY P VI | YT A

115M of 183M

D

BN INSTITUTE



p _T" T Integrative

g V Genomics
] Viewer

| Human hg18 ) [ Al B | o & « » @ W ® 0 =

- }._.L Y IPRPIEIIN  UUR PRIRE TS DTS DAY DRIV (Y TSR Y PR TE

INSTITUTE



Integrative
Genomics
Viewer

Select the reference genome

__® IGv_File Genomes Today, we will use both
8.0.0 Human hg18 and hg19

Human hgl8 | | |

If Human hg19 is not in the menu,
then click on More...




Select the reference genome

® IGV File

Genomes

® 00

Human hgl8

—

® O O Genomes to add to list

Integrative
Genomics
Viewer

é « Human hgl9

Selected genomes will be added to
the genome dropdown list.

Filter:

Human (b37)

Human (1kg, b37+decoy)
Human hgl8

Human (1kg reference, b36)
Human hgl7

Human hgl6

Select Human hg19
from the list of genomes,

and click OK

0

S1/Svim))
ro2)

Rhesus (rheMac2)

Macaca fascicularis (CE_1.0)
Rat (rn4)

Rat (rnS)

Dog (canFam2)

Dog (canFam3)

Rabbit (oryCun2.0)

Cow (bosTau7)

| OK | | Cancel |
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Select the reference genome

s § 8 N? 8 8 8 Nes o

Selected genomes will be added to
the genome dropdown list.

Human hgl8

—) *More...

Filter:

Human (1kg, b37+decoy)
Human hgl8

Human (1kg reference, b36)
Human hgl7

Human hgl6

Mouse mm10

Mouse mm9

Mouse mm8

Mouse mm7

Mouse (129S1/Svim))
Chimp (panTro2)

Rhesus (rheMac2)

Macaca fascicularis (CE_1.0)
Rat (rn4)

Rat (rnS)

Dog (canFam2)

Dog (canFam3)

Rabbit (oryCun2.0)

Cow (bosTau7)

[ ok | | cancel |
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Select the reference genome

=

Select Human hg18

Human hgl9
More...

.' IGV File Genomes

IHuman hgl8
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Load data

=

Select File > Load from Server...

.’ IGV | ill=. Genomes View Tracks

@00 .
———— " Load from File...
| Human hg | oad from URL...

Load from Server...
Load from DAS...

New Session...

Open Session...
Save Session...

Save Image ...

Exit
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Load data

Integrative
Genomics
Viewer

Available Datasets L

1.8 0.0
[V Available Datasets
» | | Annotations (hgl8)
d |» [ ] Breast Cancer (METABRIC) (D
» [ | The Cancer Genome Atlas (i)
» | | Copy Number Alterations Across Human Cancers (i)
L (hg18)
Open the s ©

Tutorials menu

umor Chromatin Profiles (i)

mals (1)

—3 0

CiKe
iKe
CiKe
CiKe

|| Body Map 2.0 (lllumina HiSeq)
| Tutorials

Al £ Ul Basics (Encode) @_

M12878 H3K27ac
M12878 H3K27me3
M12878 H3K3B6me3
M12878 H3K4mel

» [ | SNP Validation

Select
Ul Basics (Encode)

| Cancel | [ OK J

D
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Screen layout TV

Viewer

’

IGV ile Genomes View Tracks Regions Tools Geno Hel
800 IGV

( Human hg18 :) [an ) | ol B « » @ B X {2 exome =

DATA TYPFE
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s
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=
=
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1)
M
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MAME

GM12878 H3IK27ac

[S7N— . (Y W TS U T T Sy e A U P JUNEUE [y TP SRR T T T R T PR T e T . W ST

GM12878 HIK2Tme3

GM12878 H3K36ma3

GM12B878 H3K4me1

Refseq genes Lﬁ..k | VRPN ROPI ERUUIN 71 WUTRY WORRI Y GOV TPT oY VW DRI PR ARY P YN | TN R

tracks o 140M of 304M
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Screen layout

b Integrative
Genomics
Viewer

800

( Human hg18 3 [ ) | =
... Click the Home button T
- fOr whole-genome view .

GM12878 H3K4me1 IIII — ) N e

RefSeq genaes

Lﬁ..x [ TTIDTRUITTY RPN SN T WV WA S UOF TV O WOTN DRSNS S g Iwe Py PV I | RPN

140M of 304M
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2 - - -
® IGV File Genomes View Tracks Regions Tools GenomeSpace Help
| A = ]
8600 IGV
| Human hg18 s | Al a) ‘ ‘Go # « » @ @ ® 2 eome =]
¥ 1 3 5 7 9 11 12 15 17 19 21 X
£ 2 4 ] ] 10 12 14 16 18 20 22 Y
gé | | | | | | | | | | | | | | | I I N N | |
GM12878 HAK2Tac
GM12878 HAK2Tme3
GM12878 HAK36ma3
GM12B878 H3K4me1

tracks

el Ln..n | VDTSRRIV PN SURIIUIN 71 WU WORI Y UOF TVVE O WVN AR W Tt PV A I | T N A

tracks ® 140M of 304M
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Screen layout

’

@ IGV File Genomes View Tracks Regions Tools GenomeSpace Help menus
®00 GV
[Humanhng ¢] | Al ¢|i ‘\Go £ <« » % = A ﬁ tOOIbar
1]
genome
ruler 3 )

GM12878 H3IK27ac

GM12878 H3K27me3

GM12878 H3K36ma3

GM12B878 H3K4me1

tracks

RefSeq genes

LLMMM_AH“_.M“MMMJ“‘-M% genome

_ features
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Navigate

800

[ Human hgl8

=

Integrative
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Viewer

All

ik
L
|
o
U
[

GM12878 H3IK27ac

GM12878 HIK2Tme3

GM12878 H3K36ma3

GM12B878 H3K4me1

7 9 11 12 15 17
] 10 12 14 16 18 20

19 21

X
22 Y

| | | | | | | | | |
S L L S P P W S S S

—— —

e

genome ruler to
view chromosome 1

oL Iclckonthetinthe

RefSeq genaes
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Navigate

Integrative
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Viewer

8 00 IGV
| Human hg18 +] [ ehn2 4| |ehn1 (co T « » fg [ = [ Exome IR e [+]
p36.23 p36.12 p34.3 p33 p32l p31.1 p22.2 p2l.2 pl13.2 qll ql2 q21.1 q231 q24.2 q25.3 q31.3 q322 qd1 q42.2 q44
- 246 mb s
nb 20 mb 40 mb 60 mb 80 mb 100 mb 120 mb 140 mb 160 mb 180 mb 200 mb 220 mb 240 mb
| | | | | | | | | | | | | | | | | | | | | | |
[9-25)
GM12878 H3K2Tac
PRSPy 1 ST N TR U TR [ T W | TS TN T T TR o W S T T
[0-25
GM12878 H3K27me3 J
| O s i - P r— — -
10- 25
GM12878 H3K36ma3 |
il FENEF W ST T S SRR ST R S e [T T W S S e
[0-25

GM12B878 H3K4me1

RefSeq genes

UL LT L T LI LT MR T TETTE LT

e oAPRRRIR (RALUUAIY, L1, OURMIR RN ORI AR

|6 tracks

hr1:27,078,527

’
E

146M of 304M
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Viewer
| Human hg18 2] [ chr IR e [+]
[TTT I T 1 TTTT T 1 [ [ | | [ I |
'! p36.23 p36.12 p34.3 p33 p32.1 p31l.1 p22.2 q3 31_ . 42_ =
'&J ~
NE nb -¢ 180 mb 200 mb 220 mb 240 mb
ik | I | | | I I
== | Inb 20 mb 40 mb 60 mb 80 mb
GM12878 HAK2Tac I I I I I
Fi RN A I PR o N SRR RS |
[9-25
GM12878 HAK2Tme3 I [0_ 251
I [0-25
GM12878 HAK36ma3
LA Ll .-.‘Jl_-.._-..-l.uhl.LJ e m L. . o s B
I .
GM12878 H3K4me1
_-.__-.-d-J-.-.L_I.-i_.I...-L__.-.-_
. h e T o — Bl
[0-25]
"R
[0-25]
ot

~—-a=l.ssi Click and drag

from 40 mb to 60 mb

RefSeq genaes

M RIA LN

on the genomic ruler
W

L NSRRASNY L1 9LRIMIN OO A O

tracks ®

hr1:27 078,527

146M of 304M

F<BROAD

INSTITIITE




Integrative
Genomics
Viewer

Navigate

00 IGV
| Human hg18 ) [ chrl :) lchr1:39,985,114—60,230,740| IGo £ o« » &[O x 2 Sl o [+
O T T [T m— i < T I  T T T —

p36.23 p36.12 p34. p p32.1 p31.1 p22.2 p2l.2 pl3.2 qll ql2 q2l1.1 g23.1 (g24.2 q25.3 q31.3 q32.2 q4l1 q42.2 q44

W= 20 mb -

NE mb 42 mb 44 mb 46 mb 48 mb 50 mb 52 mb 54 mb 56 mb 58 mb 60 ml

;g | | | | | | | | | | | | | | | | |

GM12878 H3K27ac

|
Al s vdade e o P T S S

GM12878 H3K27me3

P R T ¢ S FRpa— — oy —~ Aa R PR p— —y -

[0-25]
GM12878 H3K36me3

DATA FILE

GM12878 H3K4me1

RefSeq genes AN — JLBIT R L 8] Lo, L RO IR L, D B |
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Navigate

=

800 ~ chrl : chrl:39,985,114-6
Human hg18 » @ M = 2 =IO e =]
p36.23- p36.12 p34.!—I 5 p32.
20 mb >
: 50 Imb : 52|mb ! 54|mb 58|mb | 58|mb ! SOlml
-
mb 42 mb 44 mb _._-.l_llu.l._l..l..L.nI. wl 1 R N S TV S
GM12878 H3K27me3 I I I I |
GM12878 H3K36me3 [0 N 25] A o
GM12878 H3K4me1 -
Ln..l-.‘l Ha lll.l.j_d.l._._ T
[0-25]
n Double-click to
zoom in for closer
02 view of peak
LVOUR(FAL R — SRMAT R  L 10] O H LI A RE H,  IH B
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800

IGV

[ Human hg18 :] [ chrl

4| chrl:39,303,220-44,695,249 Go Ft « » @ [ = 2 El o e [+]

M_Hmm
p36.23 p36.12  p343  p33 p32.l p31.1  p222 p212 pl132 qll ql2 q2L1 q23.1 q242 q253 q3L3 q322 q4l  q422  qad

DATA TYPE

NAME

5,380 kb >

40,000 kb 41,000 kb 42,000 kb 43,000 kb 44,000 kb
| | | | | | |

GM12878 H3K27ac

GM12878 H3K27me3

[0-25]
GM12878 H3K36me3

DATA FILE

GM12878 H3K4me1

W TISRV R Y1) [V TR |JY TSN TI IR UTY SO O W (1 1 '

| I+ T Ny N ST

aaiibibd 2k ko di A Beae. PORGTERE YR DU TN Sy

PO T — _..‘—L_‘

S N R

RefSea genes P LR LR RN SR R et T L g, R, R L G
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Navigate

® O O IGV
[ Human hg18 s [ chr1 4| chr1:39,303,220-44,695,249 Go Ft « » @ [ = 2 =R (A
| I EmRER W B W E—— . e R
p36.23 p36.12 p34. p33 p32.1 p31.1 p22.2 p2l.2 pl3.2 qll ql2 q21.1 g23.1 (g24.2 q25.3 q31.3 q32.2 q41 q42.2 q44
o 5,380 kb ~
-
w t o 40,000 kb 41,000 kb 42,000 kb 43,000 kb 44,000 kb
55 ! | | |
355

. ;_th.u L. d_hlh ol LLILJ].;;.-I__

- . FOERENE TR0 IR W TR
.._.J....I.Lu..L_J___.

Click anywhere

In the data panel

O and drag tracks

left and right

I I I I
m
GM12878 H3K27ac
u_ll-.lull. Jli_l.nl.lul ; ..IJ.L_ L ..l
[0-25]

GM12878 H3K27me3
| I+ T Ny N ST b _..‘—L_A

[0-25]

GM12878 H3K36me3

GM12878 H3K4me1

RefSaq genes P LR LR RN SR R et T L g, R, R L G

6 tracks ichr1:42,029,589 130M of 317M
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® O O
' Human hg18

Sl
= ( Go )

chrl
CITT I T 1 TTT1T T 7 -
p36.23 p36.12 p34.3 p33 p32.1 p31.1 p22.2 | 5,m|mkb | 4s,ov|mkb |
. Type gene name or other RefSeq
ames ™ 2me o «m | gnnotation into the Search Box
GM12878 H3K4me1 ] and CIiCk Go
Ll L.-JI_L_LJ_M.LLJM shen 2 omeel o _.a o em.m
[0-25]
. Oh- e W HE R R, I | R R U R

chr1:43,131,019

145M of 317M
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Navigate v [l

Viewer
® 00 I
| Human hg18 ; El o e [+]
chrl v C NRAS Go
242 q25.3 q31.3 q32.2 q41 q42.2 q44
I—I I_I - I—I |_I LI I I - 5,000 kb 46,000 kb
p36.23 p36.12 p34.3 p33 p32.1 p31.1 p22.2 | | | |

GM12878 H3K27ac

GM12878 H3K27me3

GM12878 H3K36me3

GM12878 H3K4me1

1]} a1, |

nb

Type gene name or other RefSeq
. ®" | ®*™ |annotation into the Search Box

[0-25]

[0-25]

o] L.-JI_L_LJ_M.LLJM snne 2 el - o em ol memoam

and click Go

RefSeq genes

S L R LU Y L T N e L r e R e R L

chr1:43,131,019 145M of 317M
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® O O IGV

| Human hg18 s | chrl t| chr1:115,046,608-115,063,038 Go T <« » @ [ = [

= NIRRT [

WM
p36.23 p36.12  p343 p33 p32.1 p31.1  p222 p212 pl32 qll ql2 q2L1 q23.1 q242 q253 q3L3 q322 q4l  q422  qad

- 16 kb

115,048 kb 115,050 kb 115,052 kb 115,054 kb 115,056 kb
| | | | | | | | | | |

DATA TYPE
DATA FILE

NAME

115,058 kb 115,060 kb 115,062 kb
| | | | |

[0-25]

GM12878 H3K27ac - .
N S S S ~ U, —— |

[0-25]
GM12878 H3K27me3

| —— —_ —— — —t— —_—— N — —_

| 0-29
GM12878 H3K4me1

|| 0-25
GM12878 H3K36me3

RefSeq genes < < < < < < l . NRAS . CSDE1
tracks chr1:115,051,417 148M of 317M
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8 00 IGV
' Human hg18 $) | chrl | chrl:115,046,608-115,063,038 Go T <« »
[ T ] | H H W IN
p36.23 p36.12 p34.3 p33 p321 p31.1 p22.2 p21.2 pl
w | q313 322 q41
[N
ﬁﬁ
%,‘E,‘; | 115,048 kb ! 115,0|50 kb ! 115,0I52 kb ! 115,0|54kb
5535
[0-25]
GM12878 H3K27ac
T
[0-25)
GM12878 H3K27me3 115,060 kb
[ — —_ —— — —t— —_—— —
[0-25]
GM12878 H3K36me3
e
GM12878 H3K4me1
‘L‘ — b e il —

Click on the last tick on the
“railroad track” to zoom in
to maximum resolution

RefSeq genes

l—<—-

NRAS CSDE1

tracks chr1:115,051,417

148M of 317M
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® 0 0 IGV
| Human hg18 s [ chrl t| chr1:115,054,795-115,054,835 Go T <« » @ [ = [ e iy =+
mll ql2 q21.1 g23.1 (g24.2 q25.3 q31.3 q32.2 q41 q42.2 q44
wf 42 bp -
w E i 115,054,800 bp 115,054,810 bp 115,054,820 bp 115,054,830 bp
ggg | | | | | | |
[0-25]
GM12878 H3K27ac
I [0-25] - —
GM12878 H3K27me3
[0-25]
GM12878 H3K36me3 I - . -
o Tl Maximum zoom.
— ’
We've moved from
whole genome to
base pair resolution Reference
sequence
Sequence - AT GGTAGC CTCCTATTAACTTGTAGTATTTTTSGT CTTTTTTT GCTASTC
RefSeq genes NRAS
6 tracks chr1:115,054,814 03M of 317M
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Viewing multiple regions TV E

Viewer

« Search box
Enter multiple loci or features in the search box

8006
[Human hgl8

[ T e e

J———
pis3 p13.2 p13.12  pl23 pl2.1 pii.2 pll.1

 Regions > Gene Lists...
Select from a number of pre-defined gene lists, or
Create your own persistent list
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iewing multiple regions
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800 IGV.
Human hg18 2] [chri6 Sl lco #| « | » ||| ®|2 e =l
chr12 chri2 chr16
2 S s
g‘; chrl2:40739052-41147391 chrl12:52642358-52648797 chrl6:8121350-13070296
Y
323
[0-25 1025 10-25
GM12878 H3K27me3
. PR ettt i RS Mooty . o
[0-25) [0-25 [0-25

GM12878 H3K36me3 | I | I I I I lII
e ——— —_— —e—— — — _“m-l__—.-—l_—Llh“-lM.
[0-25) [0-25) 0-25
GM12878 H3K4me1
Mwhimm_ — e itinn ol e e omm _.____JMWL

0-29 0-29 -2
GM12878 H3K4me2 | I I -l- l |Il | | |i ll | |||| || I
Y P e o . FUPOREN N —— — e ntee e ) ., - ....__J.I.A_JJ.IJ. l

tHHHH — - —— LA - s (HEF S IHHEL PR

GXYLT1 YAF2 ZCRB1 PPHLN1 PRICH HOTAIR TMEM114 GRIN2A TEKT5 TNP2 GSPT1 CPPED1 D

RefSeq genes




Viewing multiple regions TV e

Viewer

To go back to the standard, single-region view:

» double-click on a region label — or —
* right-click and select “Switch to standard view”

[ YeYe) IGV
Human hg18 3] [chri6 10 Go| | « | » | [ x| R e
chr12 chr12 chr16
(T O T T O T T o [ T i o o« [ [ B | B[
;‘g‘ chrl12:40739052-41147391 chrl2:52642358-52648797 chr16:8121350-13070296
Yo :::
323
[0-25) 0
Tme3
e - il ol e e dboub iy . . —
[0-25)

78
0-2 029
e e .._mmg.k;l. M
_MJ-LM_ML S P S ——
[0-25) [0-25) [0-2:
8 H3K4me2 I ' J- I
Y P el - .L;A.._..L_-J.__.
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File formats and track types

« The file format defines the track type.
* The track type determines the display options
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File formats and track types T Conorics

Viewer

* The file format defines the track type.
* The track type determines the display options

« |GV supports many different file formats.

= BAM « GCT = PSL

« BED « genePred « RES

= BedGraph « GFF « SAM

= bigBed = GISTIC = Sample Information
= bigWig = Goby «» SEG

= Birdsuite Files = GWAS = SNP

» broadPeak = IGV « TAB

= CBS « LOH = TDF

= CN =« MAF (Multiple Alignment Format) = Track Line
= Cufflinks Files = MAF (Mutation Annotation Format) = Type Line
= Custom File Formats = Merged BAM File « VCF

= Cytoband « MUT « WIG

= FASTA = narrowPeak

 For current list see: www.broadinstitute.org/igv/FileFormats
Eg BROAD

INSTITUTE
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Genome annotation track

UCSC style gene representation

N N N N N N N l N N l l N N N l N N N N l N l N
rd rd rd rd rd rd rd l rd rd l ' rd rd rd l rd rd rd rd l rd l rd
T \ LANCL2 T

5 UTR Intron Exons 3 UTR

Zoomed in views

~ .
e

CGCGCGG G T GCGGCG G Cc C TGCTC

LANCLZ

Zoomed out views

-.I.Ilh...;.ﬂ“..ﬁaﬂ_l_uu._.l. .Mm
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Annotation display mode

1. Features are drawn in a single row, by default

EGFR EGFR

2. Expand the track using the popup menu

RefSeq genes !

Rename Track...
Change Track Color...
Change Track Height...
Change Font Size...

v Collapsed
Squished

Expanded

Copy Details to Clipboard
Copy Sequence

Set Feature Visibility Window...

Remove Track

- v
m
O
-
=

5 5 5 5 5 5 5 5 Save image...
e e e e e e e e N
EGFR
l/ s s s s s s s s
EGFR
l/ s s s s s s s s s
EGFR
L. 5 5 5 5 5 5 5 5
e

2\

| ? ? ? ECF/R ? ? ? H—'I'I'I" E{B OAD
N
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Annotation display mode

Integrative
Genomics
Viewer

3. For a compact view of all variants use “Squished”

,’ RefSeq genes

Rename Track...
Change Track Color...
Change Track Height...
Change Font Size...

Collapsed

v Squished

Expanded

Copy Details to Clipboard
Copy Sequence

Set Feature Visibility Window...
Remove Track

Save image...

B HHHHHH—H———Ha-
I H—HHHHH

| o AH—HHHH

[ H—HH
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Reference sequence T cooaie

Viewer

Click anywhere on the sequence to see a 3 frame translation.
| Il
Sequence —) FEGGTCAGGAGTCE

By default the sequence for the forward strand is shown.
| [

|Sequenoe -’H'GAGGTCAGGAGTCT

Click the arrow on the left to reverse the strand.

1 |
Sequence <FﬂCTCCAGTCCTCAGﬁ

E<BROAD
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View

ing alignments

Whole

chromosome view

Integrative
Genomics
Viewer

006 IGV
(Human hg18 W8] [ chr1 %] chr1 Go £t « » m o= =2 =] e
p36.23 p36.12 p343 p33 p321 p3l.1  p22.2 p21.1 pl31 ql2 q21.1 q23.2 q243 q253 q31.3 q32.2 q42.11 q43
-+ 246 mb -
nb 20 mb 40 mb 60 mb 80 mb 100 mb 120 mb 140 mb 160 mb 180 mb 200 mb 220 mb 240 mb
| | | | | | | | | | | | | | | | | | | | | | |
NA19240 SLX (YRI daughter) Co| (€%
age
NA19240 SLX (YRI daughter) Zoom in to see alignments.

RefSeq genes

28269 KAZN SYF2 SFPQ STIL CBA AK4 CRYZ UOX DR1

I O AU DU A OO | ) R

RNPC3 NRAS

NR_033189 IFI16 XCL2 ABL2 FAMSC PKP1 RD3

SR R O 1 O O 1 O

HHIPL2 RBM34 NLRI

|4 tracks loaded

|[chr1:95,509,957 i

|[185M of 266M

E
NN

BROAD
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Viewing alignments

Zoom in to view alignments

eno IGV
(Human hg18 5] [chn I4] chr1:95,625,439-95,649,303 Go Ft « » @[ = 2 = RN (N |
p36.23 p36.12 p35.1 p341 p32.2 p31.2 p223 pll3 p133  pl2 q12 q21.1 q22 q24.1 q25.2 q31.1 q321 q323 q4211 q423 q44
23 kb
95,626 kb 95,628 kb 95,630 kb 95,632 kb 95,634 kb 95,636 kb 95,638 kb 95,640 kb 95,642 kb 95,644 kb 95,646 kb 95,648 kb
| | | | | | | | | | | | | | | | | | | | | | |

E3

NA19240 SLX (YRI daughter) Co| |©~ % M

| l ‘ ! I| N ¢
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|

NA19240 SLX (YR! daughter) |
|
@
a
v

RefSeq genes

l4 tracks loaded ||chr1:95,634,860 I

|[p4am of 397Mm E

Integrative
Genomics
Viewer
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Viewing alignments

ﬁ Integrative

1

Coverage track now has more detail

Genomics
Viewer

["Human hg18 ) (chr1 4] chr1:95,625,439-95,649,303 Go Ft « » @[ = 2 S
p36.23 p36.12  p35.1 p34.1 p32.2 p31.2 p223  pll3 p133  pl2 ql2  q211 q22 q24.1 q25.2 q31.1 q321 q323 q4211 q423 q44
23 kb
95,626 kb 95,628 kb 95,630 kb 95,632 kb 95,634 kb 95,636 kb 95,638 kb 95,640 kb 95,642 kb 95,644 kb 95,646 kb 95,648 kb
| 1 1 | | 1 | | 1 1 | 1 | | | | | | | 1 | | 1 1
NA19240 SLX (YRI daughter) Co| %
age
I
[
NA19240 SLX (YRI daughter)
RefSeq genes
4 tracks loaded hr1:95,634,860 44M of 397M
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ighmen

Zoom in to see more detall

iewing a

Vv

Bases that do not match the

{BROAD

sion: /Users/helga/igv_ses:
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Viewing alignments

Zoom in to see more detall

(s JoXé) IGV - Session: /Users/helga/igv_session.xml|
("Human hg18 ) (chn I#] chr1:95,638,013-95,638,360 Go Fft « » @O & 1 =R e
! I O B BN [l .
p36.23 p36.12 p35.1 p341 p32.2 p31.2 p223 pl13 p133  pl12 ql12 q21.1 q22 q24.1 q25.2 q31.1 q321 q323 q4211 q423 q44
348 bp
95,638,100 bp 95,638,200 bp 95,638,300 bp
| | | | | | |
NA19240 SLX (YRI daughter) Co| |©** ‘n
| |
1 ]
1 i | 1 | (]
1 [
1 1 1 1 I 1
1 [ I
1 Il
1 1 If I
1 | Il 1 1
1 1 1 11
il L)
I | !
1 | [
1 | u I
1 | i
1 1 I
1 1 i 1
. I il
11 1 1 It
| 1 1 1 1
1 1 I
| | 1 [
1 nrrrr mo1 :: 1 1
1
11 1 b
NA19240 SLX (YRI daughter) 1 1 i
1
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Viewing alignments

Zoom in to see more detall

eno IGV - Session: /Users/helga/igv_session.xml
Human hg18 BREE 3]  chr1:95,638,056-95,638,095 Go Fft « » @O & 1 Sl &=
! I O BNl .
p36.23 p36.12 p35.1 p341 p32.2 p31.2 p223 pll13 p133  pl12 ql12 q21.1 q22 q24.1 q25.2 q31.1 q321 q323 q4211 q423 q44
40 bp
95,638,060 bp 95,638,070 bp 95,638,080 bp 95,638,090 bp
| | | | | | | |
NA19240 SLX (YRI daughter) Co| [ * T
m
c [
G G | I
I
c [
-
c i
c I
c i
c | |
c .
(] [
c -
c (B
(5 | |
c i
c I
I
c I
c i
c i
c [
c T : : c T T T
T c i
NA19240 SLX (YRI daughter) c i i
c i
- v
¢ i c C
I
c [
c [
c i
C ¢ P
c -
c [
c
L]
- Low-quality base
(o
c
c L
: calls are faint
c
c J
Cc
C c c
- c A
¢ Sellll-trallsparent ;
L ]
Sequence - Cc G G T G T T C T G T G G G T
ferseqgene B ROAD

l4 racks loaded [fenr:25,638,070 I [[p3om of 3970 INSTITUTE




Viewing alignments

Integrative

[YeYe) IGV.
(‘Human hg18 1) ((chn1 [#]  chr1:95,625,439-95,649,303 Go Fft « » @[ = 2 Eoeeafen =
[ S e (B .
p36.23 p36.12 p35.1 p341 p32.2 p31.2 p223 pl3 p133  pl2 ql12 q21.1 q22 q24.1 q25.2 q3l1.1 q321 q323 q4211 q423 q44
23 kb
HOW far do you need to 95,636 kb 95,638 kb 95,640 kb 95,642 kb 95,644 kb 95,646 kb 95,648 kb
| | | | I} | | I} | | | | |
oom in to see the alignments?
Z | g ! T
I L ;
|
|
|
|
I
|
|
|
|
|
|
|
|
|
|
|
|
I
|
NA19240 SLX (YRI daughter) :
~L1

Genomics
Viewer
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Viewing alignments

Human hg18 i3 [(chn [%#]  chr1:95,625,439-95,649,303 Go Ft « » @[ = Ennmnnn

How far do you need to ame ame | ame  me e e ae
zoom in to see the alignments?

4

30 kb | or set a different threshold
in preferences

NA19240 SLX (YRI daughter)

T
|
!
!
!
!
!
!
!
!
!
!
!
!
!
!
!
!
!
!
!
!
!
@

 Higher value (larger region) =» requires more memory
* Low coverage files =» ok to use higher value
* Very deep coverage files = use lower value

g DROAR



Viewing

alignments

eno IGV - Session: /Users/helga/igv_session.xml
[ Human hg18 ) [chn1 4] chr1:95,625,439-95,649,303 Co Bt « » @[ = 2 S =
[ W W W W
p36.23 p36.12 p35.1 p341 p32.2 p31.2 p223 pll3 p133  pl12 q12 q211 q22 q24.1 q25.2 q31.1 q321 q323 q4211 q423 q44
23 kb
95,626 kb 95,628 kb 95,630 kb 95,632 kb 95,634 kb 95,636 kb 95,638 kb 95,640 kb 95,642 kb 95,644 kb 95,646 kb 95,648 kb

1 1 1 | | | | | 1 1 1 | | | | | 1 1

NA19240 SLX (YRI daugmter) Col
age

NA19240 SLX (YRI daughter)

Downsampling:
« limits displayed read depth
* uses less memory

RefSeq genes

{4 tracks loaded

[fenr1:95 629,923 Il

|[155M of 397M

S

/)

A

Integrative
Genomics
Viewer
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Viewing SNPs

Hands-on exercise

« Load alignments from whole genome sequencing
* View sites where SNPs were called
« Sort and color to highlight patterns
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Viewer

Viewing SNPs

=

.’ Genomes View
MG W S —

Load from File...

 Human hg | pad from URL...
Load from Server...
Load from DAS...

— New Session.. Before we start:
Open Session...

Save Session... Select File > New Session
Save Image ... to clear IGV window

Exit

E<BROAD
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=

Viewing SNPs

Genomes View

Load from File...
Load from URL...

Load from Server... Select File > Load from Server...
Load from DAS...

New Session...
Open Session...
Save Session...

Save Image ...

Exit

E<BROAD
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Genomes View
Load from File...
Load from URL... -
Load from Server... Select File > Load from Server...
Load from DAS...

New Session...
Open Session...
Save Session...

Save Im¢ © O O

Available Datasets

Exit

v Available Datasets

| Annotations (hg18)

| Breast Cancer (METABRIC) (i)
| The Cancer Genome Atlas (i)

>
>
>
>

(hg18)

Open the s @

Tutorials menu Fmer Chromatin Profiles (i)
mals (i)

:\ Body Map 2.0 (Illumina HiSeq)

—)(E) Tutorials

» | | Ul Basics (Encode)
M T SNP Validation e —es—
¥ SNP Calls

 WGS Alignments

 Copy Number Alterations Across Human Cancers (i)

Select
SNP Validation




Viewing SNPs

Integrative
[ Genomics
Viewer

Type “snp1” in the Search Box
and click Go
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® O O IGV
| Human hg18 s [ chnl 4| chr1:9,718,605-9,718,645 Go Fft « » @[ = & =l [+
- 41 bp .
9,718,610 bp 9,718,620 bp 9,718,630 bp 9,718,640 bp
| | | | | | |
[0- 50
WGS Alignments Coverage l
Lot
.
| |
P
Il
Tl
Tl
-
LTl
Lol
LTl
Lot A
A Tl
| |
WGS Alignments | |
i A
T i
Lot
L7l
LTl
LTl
iTi c
Lol
Lol
Lol
Lol
T
Lol
[
Sequence =/|/|C T T CTTATU CU CGU CGAGTTTT CTCT CGGAACGGAGAGTTAAGT CTCAG
RV K K D A L K @ S R L T L G A
CLSTN1
-
SNP Calls
snp1
5 tracks loaded
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Viewer
® 00 IGV
| Human hg18 s [ chnl 4| chrl:9,718,605-9,718,645 Go Fft « » @[ = & =l [+
e < o L L N N
- 41 bp .
9,718,610 bp 9,718,620 bp 9,718,630 bp 9,718,640 bp
| | | | | | |
[0- 50 A
WGS Alignments Coverage l
If necessary, click and drag
the window divider for a
larger data panel
1 A
A Pl
WGS Alignments : :
CLSTN1
Sequence =||/|lC T T CTTA A T A A G CCAG
RefSeq genes K K - L G A
SNP Calls
snp1

5 tracks loaded

hr1:9,718,618

02M of 266M N E
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| Human hg18 s [ chrl :| chrl:9,718,605-9,718,645 Go Fft « » @[ = & Sl il =
p36.g3 p36.12 p34.3 p33 p321 p31.1 p22.2 p21.1 pl3.1 ql2 q21.1 g23.1 q24.2 q25.3 q313 q32.2 g4l q42.2 q44
- 41 bp .
9,718,610 bp 9,718,620 bp 9,718,630 bp 9,718,640 bp
| | | | | |
[0- 50]
WGS Alignments Coverage l
L
I
I
; : Sample = NA12878
i I i ‘Read group = ERR001757
; T : ‘Read name = 1L10_385:6:180:155:338
i T i ‘Location =chrl:9,718,629
i ‘Alignment start = 9,718,628 (-)
iTi Cigar = 36M
i Mapped = yes
A | T | Mapping quality = 70
| |
WGS Alignments i } Base = A
! T I ‘Base phred quality = 6
T [N ]
[ ! Pair start = chr1:9718480 (+)
Tl Pair is mapped = yes
Irl Insert size = -184
; ; : Pair orientation = F2R1
. First in pair
o T
[ H1l =
| |
i - i 'MF =18
i i RG = ERR001757
: : NM=1
Sequence CTTCTTATCCGCGAGTTTCCCGGAACUQ=4 C C A G
RefSeq genes =25
CLSTNT [ e
||
SNP Calls
snp1

5 tracks loaded




Viewing SNPs

e 00

| Human hgl8

A
v

| chrl 2

chrl:9,718,605-9,718,645

[TCN 0 T T TTTT T T W T [ I |
p36.23 p36.12 p34.3 p33 p321 p31l.1 p222
9,718,610 bp 9,718,620 bp

I .
q23.1 q24.2

[
q25.3

Integrative
Genomics
Viewer

CELETEE e oy [+]

[T 0]
g32.2 q41 q42.2 q44

9,718,640 bp

Click on yellow balloon icon =
In the toolbar to modify the
information popup behavior

o4 4 4 ==+

=== ==

|
i
i
i
i
i
i
i
i
i
i
i
i
i
WGS Alignments |
i
i
i
i
i
i
i
i
i
i
i
i
i
i

‘Sample = NA12878
‘Read group = ERR001757

‘Read name = 1L10_385:6:180:
‘Location =chrl:9,718,629
‘Alignment start = 9,718,628 (
Cigar = 36M

Mapped = yes

Mapping quality = 70

‘Base =A
‘Base phred quality = 6

! Pair start = chr1:9718480 (+)
Pair is mapped = yes
Insert size = -184
Pair orientation = F2R1

Firstin pair

'RG = ERRO01757

NM=1

Sequence =/||lC T TCTTA AT CU CG CGAGTTTZ CC CZ CGGAAGTC

RefSeq genes

CLSTN1
L

SNP Calls
snp1

155:338

|
:
:
:
5
:
:

G C C A G

5 tracks loaded
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® O O IGV
| Human hg18 ) [ chrl | chr1:9,718,605-9,718,645 Go Fft « » @[ = & Sl =l

p36.!3 p36.12 p34.3 p33 p321 p31.1 p22.2 p21.1 pl3.1

ql2 q21.1 g23.1 q24.2 q25.3 q313 q32.2 g4l q42.2 q44

Click & drag to

position mismatched .
= | hases between the :

center guidelines

SNP Calls

Sequence =/II|[C T TCTTATT CC CGT CGAGTTTTZ CT CT CG GG GAACGGAGAGTTAAGT CTCASG
R K K D A L K G S R L T L G A
efSeq genes

CLSTN1
L

\D
5 tracks loaded hr1:9,718,618 02M of 266M TE
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| Human hg18 $) | chrl +| chr1:9,718,605-9,718,645 Go Ft « » @ [ ® RN R RANRANTN R

WGS Alignments

Rename Track... |
Copy read details to clipboard I
|

WGS Alignments Coverage

Group alignments by
Sort alignments by start location |
- Color alignments by read strand |
| first-of-pair strand |

} Shade base by qually e

|~/ Show mismatched bases mapping quality
. Show all bases

sample I
.| Right-click on alignments and select read group i
Sort alignments by > base en f:gf°m°S°me of mate |
Il g "t TUTTTITEE ORI
On Mac: Right-click = 3-click |ali

Sequence = |/lC T TCTTA AT CT CGC CGAGTTTU CCZCGG GAACGGAGAGTTAAGT CTCASG

RefSeq genes

SNP Calls

snp1 D
5 tracks loaded ihr1:9,718,618 i02M of 266M I! N E
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Viewing SNPs

' Human hg18 IREE 4| chrl:9,718,605-9,718,645 Go ft « » @& [ = 0 Sl oy =

!- B T Y N BN (>« T T T 7 7 N W T 7 N [T
p36.23 p36.12 p34.3 p33 p321 p31.1 p22.2 p21.1 pl3.1 ql2 q21.1 g23.1 q24.2 q25.3 q313 q32.2 g41 q42.2 q44
- 41bp -
9,718,610 bp 9,718,620 bp 9,718,630 bp 9,718,640 bp
| | | | | | | |
[0- 50]
WGS Alignments Coverage l
I 71 c
0 iTi
i1
T
i
T
T
iTi
iTi
i1
i1
i
T
A i
WGS Alignments Tl
iTi
T
iTi
7 A
7
i
T
i
i
i
i
i
i
|
Sequence =|I/[C T T CTTATT CUC CGTCGAGTTTT CTCTCGGAACGGAGAGTTAAGT CTCAG
RefSeq genes K K D A L K G S R L T L G A
CLSTN1
||
SNP Calls
snp1 D
5 tracks loaded |lchr1:9,718,607 i |[237M of 266M TE
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| Human hg18 | | chrl :| chrl:9,

[ | [ ] [ T T1 [T 1
p36.23 p36.12 p34.3 p33 3.1 q24.2 q25.3 q313 q322 q41 q42.2 q44

9,718,610 bp . T ‘ A:1 (2%, 0+, 1- ) bp 9,718,640 bp
! I'T c:17 (40%, 10+, 7-)

' = IMG:o
WGS Alignments Coverage ‘ . T‘T : 25 (58%, 13""', 12—)

.T‘N:O

WGS Alignments

Mouse over red & blue bar in coverage track. | -
Note allele counts and frequencies.

Sequence =(|[C T TCTTATT CU CGT CGAGTTTT CC CCGS GAACGGAGAGTTAAGTCTCAG
RefSeq genes K K D A L K G S R L T L G A
CLSTN1
(]

SNP Calls
D

5 tracks loaded |lchr1:9,718,607 | |[237M of 266M TE
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Viewer

800 |
| Human hg18 3] [ chrl :, « » @O = 2 Sl [+

Type “Snp2” in the Search Box 13.1 a1z q211 q23.1 q242 q253 q31.3 q322 q4l q422  qad

41 bp ~

a n d CI i C k G o 159,464,360 bp 159,464,370 bp :&

TT1
1171
[0- 56]
WGS Alignments Coverage
| |
i
c ici
i
i
i
i
N
ccc ¢ ici
| | A
i
c ici
i
ici
WGS Alignments c | |
i c
i
i
i
i
i
i G
i
Note: ol
Cc
. i
[
i
i

Large % of low quality base calls,

and scatter of “C” mismatches s s semmm———

|
SNP Calls

snp2

5 tracks loaded chr1:159,464,343
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| Human hg18 $) | chnl 5 }snp2| | co T« » @O =® 2 el =
mm
p36.23 p36.12 p34.3 p33 p321 p31.1 p22.2 p21.1 pl3.1 ql2 q21.1 qg23. q24.2 q25.3 q313 q32.2 g4l q42.2 q44
- 41 bp =
159,464,340 bp 159,464,350 bp 159,464,360 bp 159,464,370 bp 14
| | | | | |
[0- 56]
WGS Alignments Coverage
G C
Click & drag to —
n n n A
position locus with c
. y
WGS Alignments
5 blue C’s between c
G
Sequence =((f[A G T ATUCGG GG GAGAT GACTACACAGCT CACTT CTGACCTCTA AGSGA
PSR — Y R G D D Y T A T L T L G
TOMM40L
[ ]
SNP Calls
snp2

5 tracks loaded
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® 00 IGV
| Human hg18 | | chrl 4| [sanl ]Go T <« » @ T
WGS Alignments
I
p36.23 p36.12 p34.3 p33 p321 p31.1 p22.2 p21.1 pl3.1 ql2 q21.1
Rename Track...
o 41bp Copy read details to clipboard
159,464,340 bp 159,464,350 bp 159,464,360 bp

I I I I Group alignments by
o Sort alignments by
Color alignments by

WGS Alignments Coverage

v Shade base by quality

|
|
G c ici .
L v Show mismatched bases
i " Show all bases
| |
P |\ :
c c c ici | View as pairs
| |
P ~ Go to mate
| | 5 . . .
© o } View mate region in split screen
WGs Algnments - - ~ Setinsert size options ...
| |
| | ‘
| |
| |
| |

Right-click on alignments and select :
Shade base by quality

BN E
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« Paired reads can yield evidence for genomic “structural
events”, such as deletions, translocations, and inversions.

Structural events

« Alignment coloring options help highlight these events
based on:

 Inferred insert size (template length)

« Pair orientation (relative strand of pair)
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Interpreting inferred insert size

The “inferred insert size” can be used to detect
structural variants, including:

* Deletions
* |nsertions

* Inter-chromosomal rearrangements: (Undefined
insert size)
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Deletion

What is the effect of a deletion
on inferred insert size?
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Inferred insert size is > expected value
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Deletion

Pairs with larger than
6.08 expected insert size
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Note drop in coverage
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Insert size color scheme

« Smaller than expected insert Size. g
« Larger than expected insert size:
« Pairs on different chromosomes

Each end colored by chromosome of its mate
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Interpreting Pair Orientations
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Interpreting pair orientations

Orientation of paired reads can
reveal structural events, including:

* Inversions
* duplications

* translocations

Orientation is defined in terms of
 read strand, left vs right, and
* read order, first vs second

E<BROAD

NSTITUTE



Inversion KL Itearatve

Viewer

Reference
genome

E<BROAD

M INSTITUTE



Inversion I ntegrative

Viewer

Reference
genome

E<BROAD

INSTITUTE



Integrative
Genomics
Viewer

Inversion

Reference
Genome A B

Subject .

E<BROAD

INSTITUTE



Inversion KL Itearatve

Viewer

Reference
Genome A B

Subject -

E<BROAD

AN INSTITUTE

l



Integrative

Inversion KL rtegrativ

Viewer

Reference
Genome A B
q
A
|
|
|
|
|
|
Subject |
| B A
q. ....... h

E<BROAD

M INSTITUTE



Inversion KL Itearatve

Viewer

Reference
Genome A B

q q

/’7
PR
PR
PR
PR
PR
PR
Subject e
B Phg A
q. ....... h

2\

E<BROAD

INSTITUTE



Integrative

Inversion KL rtegrativ

Viewer

Reference
Genome A B

Subject -

E<BROAD

M INSTITUTE



Integrative

Inversion KL rtegrativ

Viewer

Reference
Genome A B
q q
o
A
|
|
|
|
i
Subject I
B A
q ....... h i
— -+ —
«.B OAD

I)

INSTITUTE



Inversion KL Itearatve

Viewer

Reference
Genome A B
--'> --'>
<_V G
S
LN
L
L
N
LN
S
LN
Subject I N
B S A
q ....... h \\
q ....... h
% BROAD

M INSTITUTE



Inversion KL Itearatve

Viewer

Reference
Genome A B

2\

E<BROAD

INSTITUTE



Integrative
Genomics
Viewer

Inversion

Reference
Genome

Anomaly —
Expected pair orientation is

inward facing (wp )
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Color by pair orientation
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Group alignments by |3
Sort alignments by |3 |
Color alignments by > no color ‘
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Note drop in coverage
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Interpretation of read pair orientations

Category lllumina SOLID
' ' 1 ! ! 2 2 ' 1
1 ' ! ' 1 ' 2 ' 2 . 1
L e== o= o A = = T = =D
' ' ' ! ! 1 '2 '2 1
' ' ' ! ! 1 2' '2 1

LR Normal reads.
The reads are left and right (respectively) of the unsequenced part of the
sequenced DNA fragment when aligned back to the reference genome.

LL.RR  Implies inversion in sequenced DNA with respect to reference.
RL Implies duplication or translocation with respect to reference.

These categories only apply to reads where both mates map to the same chromosome.

Figure courtesy of Bob Handsaker
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RNA-Seq

Hands-on exercise

« Examine tissue-specific alternative splicing.
« Data: lllumina BodyMap 2.0

http://www.illumina.com/science/data_library.iimn
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Genomes View

Load from File...

 Human hg | oad from URL...

Load from Server...
Load from DAS...

— New Session.. Before we start:
Open Session...

Save Session... Select File > New Session
Save Image ... to clear IGV window

Exit
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RNA-Seq Setup T [

« Step 1. Tune settings for RNA.

TTTTTTTTT



Integrative
Genomics
Viewer

RNA-seq alignments
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Select View > Preferences...

\y

® IGV23 File Genomes W/AUA Tracks Regions Tools GenomeSpace Help

® OO0 Preferences... IGV
Color Legends ...

[Human hgl9 :] Al

Set Name Panel Width...
v Show Attribute Display
Select Attributes to Show...
1 v Show Header Panel 7 a

Reorder Panels... | | | | |
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Click Alignments tab

| Human hg18 | © O O
| General = Tracks | Mutations = Cha ’ Alignments . obes = Proxy = Advanced lonTorrent
Visibility range threshold (kb): A30| Nominal window size at which alignments become visible
@ Downsample reads Max read count: 100 per window size (bases): |50
[ Filter and shading options
Sengercs Coverage allele-freq threshold f0.2 | Mapping quality threshold: ’o |

RefSeq genes

@ Filter duplicate reads @ Show center line

[YI Filter vendor failed reads @] Show coverage track
[ Filter secondary alignments || Show soft-clipped bases
@ Flag zero-quality alignments

20

[ ] Flag unmapped pairs

@ Shade mismatched bases by quality: '§ to

[ ] Flag insertions larger than: bases

[ Filter alignments by read group URL or path to filter file

Splice Junction Track Options

[ Show junction track Min flanking width: 0 Min junction coverage: 1

v/ Show flanking regions

Insert Size Options

These options control the color coding of paired alignments by inferred insert size. Base pair values set default
values. If "compute” is selected values are computed from the actual size distribution of each library.

Defaults Minimum (bp): 50 @ Compute Minimum (percentile): 0.5

Maximum (bp): 1000 Maximum (percentile): 99.5

[ oK

Cancel

I g =

q42.2

q44

[5 tracks foaded M of 866M
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| General = Tracks | Mutations = Charts Probes = Proxy = Advanced = lonTorrent

Visibility range threshold (kb): 500 Nominal window size at which alignments become visible - B M
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[ Filter and shading options

SEatnce Coverage allele-freq threshold  [0.2 | Mapping quality threshold: [0 | A GG A
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@ Filter vendor failed reads @ Show coverage track —‘

[ Filter secondary alignments [) Show soft-clipped bases

[_| Flag unmapped pairs ™ Flag zero-quality alignments

[ZI Shade mismatched bases by quality: s | to 20

[ ] Flag insertions larger than: bases

|_| Filter alignments by read group URL or path to filter file

@ soncen e [t S@lect Show junction track

Insert Size Options

These options control the color coding of paired alignments by inferred insert size. Base pair values set default
values. If "compute” is selected values are computed from the actual size distribution of each library.

Defaults Minimum (bp): 50 @ Compute Minimum (percentile): 0.5

Maximum (bp): 1000 Maximum (percentile): 99.5

| oK | | Cancel |
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[ Human hg18 © O O
| General = Tracks | Mutations = Charts Probes = Proxy @ Advanced lonTorrent |

Visibility range threshold (kb): 500 | Nominal window size at which alignments become visible
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Filter and shading options

SEatnce Coverage allele-freq threshold 0.2 | Mapping quality threshold: |0

RefSeq genes [QI Filter duplicate reads [ZI Show center line
@ Filter vendor failed reads @ Show coverage track
|_| Filter secondary alignments |_| Show soft-clipped bases
[_| Flag unmapped pairs ™ Flag zero-quality alignments
@ Shade mismatched bases by quality: s | to 20
[ ] Flag insertions larger than: bases
|_| Filter alignments by read group URL or path to filter file

Splice Junction Track Options

@ Show junction track Min flanking width: 0 Min junction coverage: |1

™ Show flanking regions

Insert Size Options

These options control the color coding of paired alignments by inferred insert size. Base pair values set default
values. If "compute” is selected values are computed from the actual size distribution of each library.

Defaults Minimum (bp): 50 @ Compute Minimum (percentile): 0.5

Maximum (bp): 1000 Maximum (percentile): [99.5
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® IGV 2.3 Jilll Genomes View Tracks

® OO0
— Load from File...

| Human hgl9 | 6ad from URL...
Load from Server...
Load from DAS...

Select:
File > Load from Server...

New Session...
Open Session...
Save Session...

Save Image ...

Exit
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Sashimi plot

Viewing RNA splicing with Sashimi Plots

Reference: Katz Y, Wang ET, Silterra J, Schwartz S,
Wong B, Mesirov JP, Airoldi EM, Burge, CB.
Sashimi plots: Quantitative visualization of RNA

sequencing read alignments. arXiv:1306.3466 [Q-
bio.GN], 2013



Integrative
Genomics
Viewer

RNA-seq alignments

e O 0 IGV
| Human hg19 s| | chri2 t| chr12:98,987,094-98,990,313 |(Go Tt <« » @ [ = (3 Exome[=] I
p13.31 p123 p11.23 plll ql2 ql312 ql133 ql4.2 q21.1 q21.31 q22 q23.2 q2411 q24.23 q24.32
¢y 3,213 bp
98,988,000 bp 98,989,000 bp 98,990,000 bp

Right-click over | L '
alignments

{0- 1169)
Liver Coverage

Liver Junctions I h u !*

Liver |

RefSeq Genes

tracks x hr12:98,987,154 73M of 772M

Z BROAD

INSTITUTE



RNA-seq alignments

8 00 IGV
| Human hg19 +] | chr12 3| chr12:98,987,094-98,990,313
[T ] [ 100 ] [ T T__TT1 [ [
p1331 p123 p11.23 plll ql2  ql13.12 ql133 ql4.2
&y 3,213
EE P 98,988,000 bp
355 I i !
10-472)
Heart Coverage -
4 i]
Heart Junctions * -
Heart
|
[0- 1169) )
Liver Coverage . V-\__,/I
Liver Junctions I .
I
|
|
Liver |
Il -

Se

RefSeq Genes|

ect

= Sashimi Plot

Heart

Rename Track...
Copy read details to clipboard

Group alignments by
Sort alignments by
Color alignments by

v Shade base by quality
v Show mismatched bases

Show all bases

View as pairs

Co to mate

View mate region in split screen
Set insert size options ...

Re-pack alignments

v Show coverage track

Load coverage data...

Collapsed

' v Expanded

Squished

Select by name...
Clear selections

Copy read sequence
Copy consensus sequence

Sashimi Plot
Remove Track

Save image...

Integrative
Genomics
Viewer

E<BROAD

AN INSTITUTE



RNA-seq alignments

Integrative
Genomics
Viewer

e O O IGV
| Human hg19 +| | chri2 4| |chr12:98,987,094-98,990,313 | Go Fr <« » @ O = =2 Exome[=] [ITTTTITTTIT
p13.31 p123 p11.23 plll ql2 ql3.12 ql33 ql4.2 q21.1 q21.31 q22 q23.2 q24.11 q24.23 q24.32
f—f © O O  Select Gene Track
EE 5 98,990,000 bp
153 - _ ! .
= () Heart Junctions
Heart Coverage -~
— (__ Liver Junctions SeleCt
| e T— RefSeq Genes
|
Heart
- 11
Liver Coverage
R I _
| OK | | Cancel | |=—
I
Il
I
Liver
n - :
il | 1 i
I i |
| |
| - -
ReiSenGenes — — —
tracks hr12:98,987,154 73M of 772M

QINSTITUTE

E<BROAD



Integrative
Genomics
Viewer

RNA-seq alignments

e O 0 IGV
| Human hg19 s | chr12 t| chr12:98,987,094-98,990,313 |(Go Tt <« » @ [ = (3 Exome[=] I
p13.31 p123 p11.23 plll ql2 ql312 ql133 ql4.2 q21.1 q21.31 q22 q23.2 q2411 q24.23 q24.32

® O O Select Alignment Tracks - I
: Select both

— [Q] Heart

I ™ Liver Heart and Liver

Heart Junctions

NAME
DATA TYPE
DATA FILE

| ]
! |

Heart
{0- 1169)
Liver Coverage
Liver Junctions I
Liver
RefSeq Genes
tracks x hr12:98,987,154 73M of 772M

QINSTITUTE

E<BROAD



RNA-seq alighments YA Cororice

Viewer
e OO
S e =
[0- 4792) O 89 Heart
37
L _—u
1002 145
[0- 1168) Liver
13
(1
y o o -
232~ 726 —
L 1 1 I
98987254 98988220 98989186 98990152
N - - . - ~ - - - - - - - - - - — - - ~ - -
- . —~ ~ —~ —~ —~ —~ —~ —~ —~ - Y —~ ~
I > > > > > > > > > > > > —

E<BROAD

INSTITUTE



RNA-seq alighments Conormios
Viewer
e OO
Sl oeenee e [+
0. 792) S8 9 Heart
37
_%'M 145
.J i i . . .
W 726 A —
. . A little busy. .
98987254 98988220 y . 98990152
= | ef's filterout p—->———

= low-count events

E<BROAD

INSTITUTE



RNA-seq alignments

Integrative
Genomics
Viewer

=

8 00

e EARAARAARNAART (NINARY

/———-—"11

1002

S

Right-click anywhere
over plot

;;;;====Il-----l

726

L
98987254

1
98988220

1
98989186

]
98990152

E<BROAD

INSTITUTE



RNA-seq alighments YA Cororice

Viewer

® 00
= RIRIRARARARARTY [
[0 47a2) B3 0m=89 Heart
37
Set Coverage Data Range
Select = lEdll Junctln Coverage —
Set Max Junction Coverage Range will be removed from view |
Set Color
Save Image... |
0- 1169) ' = Liver
13
(1
y - o o -
_‘;§3>[___\’:=-r~— 296 ‘--=ﬂﬁ’——’>£::}===-_’=-t*’ _

98987254 98988220 98989186 98990152

IH

> L)

E<BROAD

M INSTITUTE



- » Integrative
=-Seq alignments Genomics
Viewer
.8 O O n
ERTEARIRAARART! (AR
[0-4792) r——=1336—8° . Heart
37~
18.0.0 Input
}"i Miimm Set Minimum Junction Coverage
Enter 21&.) 20
[0- 1168 Liver
| Cancel | [ OK |
1 \ /
{
232
98987254 98988220 98989186 98990152
. > > > > > > > > > > > +— > > >
. ) - > >
—— S —

E<BROAD

INSTITUTE



- Integrative
RNA-seq alignments g Cenomic
Viewer
® OO
(=] v e [+

[0- 4792) L 89 Heart

L
[0- 1168) Liver

13
(1
d I _ .
232~ 726 —
L 1 1 ]

98987254 98988220 98989186 98990152
. > > > > > > — > > >
. I > >
I — — —

<A
E

BROAD

INSTITUTE



RNA-seq alignments

Integrative
Genomics
Viewer

IGV

| Human hg18

8.00

W E

Sequence

RefSeq genes

| General = Tracks | Mutations

Visibility range threshold (kb): 500

[2} Downsample reads Max read count: f100

[ Filter and shading options
Coverage allele-freq threshold 0.2
[QI Filter duplicate reads
@ Filter vendor failed reads
[ Filter secondary alignments
[_| Flag unmapped pairs

[ZI Shade mismatched bases by quality: '§ to

Charts Probes

Proxy

Advanced

lonTorrent

per window size (bases): |50

Mapping quality threshold: |0

[ZI Show center line

@ Show coverage track

[) Show soft-clipped bases

™ Flag zero-quality alignments
20

[ ] Flag insertions larger than:

|_| Filter alignments by read group URL or path

bases

to filter file

Nominal window size at which alignments become visible

q42.2 q44

anking width:

Insert Size Options

These options control the color coding of paired

Un-Check Show junction
track

values. If "compute” is selected values are computed from the actual size distribution of each library.

Defaults Minimum (bp): 50

Maximum (bp): 1000

@ Compute Minimum (percentile):

Maximum (percentile):

0.5

99.5

| Cancel |

E<BROAD

M INSTITUTE



igvtools

Integrative

E{ ROAD 0 Genomics

NN INSTITUTE Viewer

(\

A



igvtools

Integrative
Genomics
Viewer

A set of utilities for preparing files for efficient display.

toTDF

Converts sorted data file to a binary tiled data file (TDF).

Supported file formats: .wig, .cn, .snp, .igv, .gct

count

Computes average alignment or feature density over a
specified window size across the genome.

Supported file formats: .sam, .bam, .aligned, .sorted.txt, .bed

sort

Sorts file by genomic start position.

Supported file formats: .cn, .igv, .sam, .aligned, .bed.

index

Creates an index file for alignment or feature file.
Supported file formats: .sam, .aligned, .sorted.txt, .bed




igvtools

e Can be launched from
the IGV user interface
File > Run igvtools...

e Or run from the
command line
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igvtools toTDF

The toTDF utility converts large ASCII data files into
tiled data format (.tdf) files.

TDF files have the following advantages:
« Data is indexed for efficient retrieval.
» Data is preprocessed for zoomed out views.
« TDF files are web friendly — large data files can be

shared over the web. Only small slices of the file
are actually transferred as needed.
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The count command is used to transform alignment files
to read density TDF files, e.g. for ChIP-Seq, RNA-Seq, and

similar alignment counting experiments.

igvtools count
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Alignments Read Density

TDF format, indexed and
optimized for fast retrieval at

multiple resolution scales

Alignments in bam/sam,
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EEBROAD

NN I N



Integrative
Genomics
Viewer

igvtools sort

« Sorts IGV-supported genomic formats by start position.
* The index command requires sorted files.

Example:
igvtools sort -m 1000000 —t ~/myTmpDir inputFile.sam
outputFile.sorted.sam

« Uses combination of memory and disk to handle large files.

-m = maximum # of lines to hold in memory. When this
number is exceeded a temporary file is created.

-t = directory used to create temporary files during sorting.
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igvtools index

Creates an index file for viewing large files in bed, gff, or vcf formats.
An index is optional for bed or gff files, but required for vcf files.

An alternative indexing tool is “tabix”. Tabix both compresses and
indexes genomic files. |GV can read either type of index (igvtools or
tabix).

Example: igvtools index myFeatures.bed

The index file must remain in the same directory as the input file



Exercises

« Computing total and strand specific coverage
with igvtools

|GV batch scripting

« Controlling IGV from a web page
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